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ANNOUNCEMENTS

New User Guide: Searching WorldCat Indexes

This guide provides comprehensive information about the indexes used to retrieve records from
WorldCat. (OCLC services, including cataloging, reference, and resource sharing, now use the
same search indexes)

The guide describes MARC fields and subfields indexed for each WorldCat index and provides
information about how each index works to help construct searches that retrieve the records you
need.

Who should use this guide?
This guide is for library staff who use the following OCLC interfaces to search WorldCat.

OCLC Connexion client and browser (cataloging and Local Holdings Maintenance)
OCLC CatExpress in Connexion browser (copy cataloging)

OCLC FirstSearch (reference)

OCLC WorldCat Resource Sharing (interlibrary loan)

“Searching WorldCat Indexes” can be found at the following locations on the OCLC Web site, in
both PDF and HTML formats:

The WorldCat Documentation page:
<http://www.oclc.org/support/documentation/worldcat/default.htm=>

The FirstSearch Documentation page:
<http://www.oclc.org/support/documentation/firstsearch/default.htm=>

The Connexion Browser Documentation page:
<http://www.oclc.org/support/documentation/connexion/browser/default.htm=>

The (recently re-designed) Connexion Client Documentation page (click the link for Cataloging
documentation):
<http://www.oclc.org/support/documentation/connexion/client/cataloging/>

The CatExpress Documentation page:
<http://www.oclc.org/support/documentation/catexpress/>
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Attention Libraries That Use the OCLC MARC Subscription Service

An enhancement to the MARC Subscription service now ensures that lengthy MARC records will
show up in their entirety. Libraries that regularly add lengthy summaries or content notes to a
record or many added entries will be pleased to finally see the entire record come through in their
MARC Subscription file. This enhancement also applies to OCLC WorldCat Collection Sets,
Bibliographic Notification, PromptCat, and GovDoc services. Previous to this enhancement, these
services had record size limits of 4,096 characters. Records that exceeded these limits were
truncated. The size limit for a single record is 99,999 characters as of April 25, 2006.

OCLC; edited

GENERAL

Collection Analysis Enhancements

OCLC has released the following enhancements to the WorldCat Collection Analysis Service:

In the Interface

Graphing has been changed to show the actual number of titles instead of averages when
graphing by Publication Date. This was in response to many requests from users.
OCLC Symbols have been added to the Library names on the Limits screen. This also was
a request from users.

New separators have been added in the Data to Analyze drop-down menu for Peer
Comparisons and Predefined Groups. This will make navigation easier as people add more
comparisons to their analysis.

The maximum number of titles that can be exported has been reduced from 5,000 to 500.
This is in response to the reports OCLC received of exports failing or timing out. This is a
temporary measure while OCLC investigates ways to speed up the export process.

OCLC fixed a bug that caused some users to get a system failure page when they tried to
view their WorldCat Comparison.

They have also removed the Totals line on the Analysis Results table when users set
Limits on two or more libraries (the application was returning the wrong number of titles
in this instance).
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Permissions for one-to-one comparisons

A list is being created of libraries that have given blanket permission for their collections to be
used in one-to-one comparisons. Institutions on this list no longer have to be contacted directly in
order to be used in a one-to-one comparison. This list will be updated periodically. The list is on
the OCLC Web site in the Collection Analysis area. From the WorldCat Collection Analysis
homepage click on the About hyperlink, then the Common Questions hyperlink. Near the bottom
of the screen under the question "Is it possible to compare my collection against one other
library?" you will find the link to the blanket permission spreadsheet.

Here is the direct url:
<http://www.oclc.org/collectionanalysis/about/fag/blanket_permissions.xls>

Administration

OCLC has modified the screen where users create comparisons with OCLC-defined Peer Groups.
This change is in anticipation of the release of many more predefined Peer Groups, which are
scheduled to appear in the near future.

Also, OCLC has created a Category menu (e.g. 7ype of Materials or By Subject) and a
Subcategory menu (e.g Electronic Materials or Law) for users to navigate through to get to the
desired Peer Group. A Peer Group may be listed in multiple categories.

For instance, OCLC is creating a Peer Group of 10 institutions named "Top 10 Law Schools".
This will be listed under the Category By Subject and the Subcategory Law. It will also be
listed in the Category Academic Institutions and the Subcategory Graduate:Master's/Doctoral
Programs.

To set up an OCLC defined Peer Group, users need to go to the FirstSearch administrative
module:

<http://www. firstsearch.oclc.org/admin=>
and log-on with their institution authorization and password.

If you have questions about any of this, please contact Mark Wilhelmi in the MINITEX BATS unit
(Contact information at the end of this Mailing).

Mark Wilhelmi, MINITEX/BATS
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CATALOGING & METADATA

Connexion Client 1.60 Is Coming in June!

Connexion client version 1.60, coming in June 2006, includes the enhancements listed below. To
check your version number, go to the Help menu and select About OCLC Connexion Client.

OCLC will discontinue client 1.50 on Oct. 1, 2006. You will not be able to log on with client 1.50 as
of Oct. 1.

Changes to System Requirements (NOTE: Please share this information with your IT staff or
system administrator):

e C(Client 1.60 requires .NET 2.0

» Connexion client 1.60 requires Microsoft .NET Framework Version 2.0 to be
installed on your workstation. Previous versions of the client required .NET 1.1.
OCLC will include .NET 2.0 software when you install the client 1.60 software.
However, you may want to consider installing .NET 2.0 ahead of time to make the
client 1.60 installation faster.

» .NET 1.1 and 2.0 can both be installed on the same workstation. Client 1.50 works
specifically with .NET 1.1 and client 1.60 works specifically with .NET 2.0, even if
both versions of .NET are installed on your workstation.

» To verify the version(s) of .NET installed on your workstation, in Windows, go to
Start > Control Panel 2 Add or Remove Programs. Look for Microsoft .NET
Framework in the list of installed programs and verify the version number(s) listed.

» See more about system requirements for Microsoft .NET Framework on the
Microsoft Web site:

<http://msdn.microsoft.com/netframework/technologyinfo/sysreqs/default.aspx>

¢ Windows ME no longer supported
» Connexion client 1.60 requires Windows 2000 or Windows XP. OCLC will no longer
support Windows Millennium (ME), starting with the release of client 1.60. OCLC
will not block the client from working with Windows ME; however, no testing will be
completed and no user support will be available for use of the client with Windows
ME.

Client 1.60 Enhancements:

e Catalog electronic resources
» Enter a URL or directory path for digital resources to have Connexion extract
metadata associated with the resource and start building a bibliographic workform.
Use the new menu item Cataloging - Create - Extract Metadata. Supported file
types are .htm, .doc, and .pdf. For Web sites, create multiple records from sites
linked to the parent URL. Select a setting from the Extract Metadata dialog to
specify whether records should be automatically saved to the online or local save
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file, to apply default constant data, and to define a My Status value for each record
created.

Paste data into a single field in a bibliographic record using new menu item Edit >
Paste Unformatted. When data is copied from Web sites, a line break is very often
included at the end of each line, causing the data to be pasted into multiple fields
in the Connexion client. Paste Unformatted automatically removes line breaks in
copied data and pastes all copied data in one field.

OCLC-MARC Format Update 2006 functionality

>

In May 2006, OCLC will implement an OCLC-MARC update. Some functionality will
be available to Connexion client 1.50 users, and some will be available only in client
1.60. See Technical Bulletin 252 for detailed information. (NOTE: this document is
not yet available; a link will be provided when it is available.)

Some key changes in Connexion client 1.60 related to this update include:

» Implementation of integrating resources (bibliographic level "i") -- The Serials
workform has been renamed Continuing Resources (menu Cataloging > Create
Record > Single Record = Continuing Resources) and is used to create both
textual serials and textual integrating resources. In addition to limiting WorldCat
searches by serials, limit by integrating resources or limit by continuing
resources (which is a combination of serials and integrating resources).

= New special characters and diacritics -- new characters, which were previously
available in Connexion client 1.50 but were not yet valid can now be used:
degree sign, phonogram copyright mark, copyright mark, musical sharp,
inverted question mark, inverted exclamation point, eszett, Euro sign, left and
right curly brackets, spacing circumflex, spacing underscore, spacing grave, and
spacing tilde.

Specify fields to delete in exported records

>

Under Tools > Options =2 Export, specify one or more fields to delete
automatically in exported records, defining different settings for authority and
bibliographic records. For example, enter 938 in the bibliographic option to
automatically delete the 938 field from exported WorldCat records.

Move between fixed field elements using shift arrows

>

With fixed field drop-down lists displayed, move vertically between fixed field
elements using <Shift><Up Arrow> and <Shift><Down Arrow>. Previously, the
drop-down list option (Tools > Options 2 Record Display > Use dropdowns for
fixed fields) had to be turned off to use the keyboard to move vertically between
fixed field elements.

View non-Latin script on batch reports

>

When batch processing records that include Arabic, Chinese, Cyrillic, Greek,
Hebrew, Japanese, Korean, Tamil, and Thai script, view the non-Latin script title
data on the batch reports, using menu item Batch, View Reports. Previously, only
Latin script data was included on batch reports.
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e Local holdings maintenance
» Determine if local holdings are attached to a bibliographic record by viewing the
holdings statement in Connexion client. For example, "Held by OCL/Local OCL
holdings -- 12 other holdings" denotes that OCL has both institution and local
holdings on the record and 12 other institutions hold the item.

» Use new menu item Tools > Launch Local Holdings Maintenance to open the
Connexion browser and log on automatically using your default authorization
number and password. The Connexion browser displays the local holdings screen
for the bibliographic record displayed in the client. Use the screen to modify local
holdings data for the record.

e Specify a startup option to logon and launch WebDewey
» Under Tools - Options - General 2 Startup Options, select an option to logon
interactively to Connexion and also launch WebDewey immediately in your default
browser when you start the Connexion client.

o Apply Text Strings without assigning to a keystroke or user tool
» Apply text strings from the text string dialog using menu item Tools »> 7ext
Strings. In the dialog, highlight the text string and select App/y. Previously, you
were required to assign a keystroke or a generic User Tool to each text string.

e Problem resolutions
» Resolutions to several reported problems will be noted on the known problems
Web page:
<http://www.oclc.org/connexion/support/client_known_problems.htm>

New Training Opportunity in the Twin Cities Area

MOTSE: Cataloging Audio Materials

Come to learn how to catalog those sound recordings! This workshop will focus on descriptive
cataloging, formulating access points (including uniform titles), and a brief overview of subject
analysis (LCSH). A portion of the workshop will be devoted to non-musical recordings and new
recording formats.

This course was prepared under the auspices of Minnesota Opportunities for Technical Services
Excellence (MOTSE), a program offering the library community throughout Minnesota continuing
education opportunities in the form of workshops and self-assessment guides covering the basics
of library technical services, with support from the MN Library Services Agency and LSTA funds.

Prerequisites: Catalogers should have a basic knowledge of AACR2 cataloging rules and the MARC
format.

NOTE: The currently scheduled instance of this session, which is set for June 15, is limited to MN
librarians because it is supported by the MN Library Services Agency and LSTA grant funds. If you
are interested in sponsoring this session at another place, please contact the MINITEX BATS unit
for more information.
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Presenter: MOTSE Trainers Mary Huismann, University of Minnesota Libraries, and Kathy Blough,
St. Olaf College

Cost: No Charge

Details: Thursday, June 15, 2006

9:00 a.m. - 4:00 p.m., lunch provided

Hennepin County, Southdale Library, 7001 York Ave. So., Edina, MN

To register, go to the MINITEX Training page at:
<http://www.minitex.umn.edu/train-conf/>

Connexion Client Video Demos

Connexion client video demos have been added to the client documentation page. These brief
demos show the step-by-step actions necessary to complete tasks commonly performed in the
client.

The following two videos can be found on the Client Cataloging Documentation page:
<http://www.oclc.org/support/documentation/connexion/client/cataloging/>

e More indexes
This video demo shows how to display all indexes when searching

e Customize indexes
This video demo shows how to customize the short list of indexes when searching

The following videos can be found on the Client Basics Documentation page:
<http://www.oclc.org/support/documentation/connexion/client/basics/

e New local file
Shows how to create a new local file.

e Set default file
Shows how to set a file as your default file.

e Move records
Shows how to move records from one file to another.

o Compact/repair local file
Shows how to use the Compact/Repair feature. Use it to force the system to unlock a
record or to shrink the size of the local file.
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Additional Session Added: Using the OCLC Authority File

The MINITEX BATS unit is offering an additional session of “Using the OCLC Authority
File.” This is a two-part Webinar taking place on two separate days, May 16 and 18,
2006. Each session is 75 minutes long. For more information, and to register, please
go to:

<http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#96=>

OCLC Control Number Expansion

To accommodate the ongoing growth of the WorldCat database, a project has been launched that
will expand the OCLC Control Number (e.g., the number assigned by OCLC and stored in the 001
field of the MARC Bibliographic Format in OCLC exported records). Currently, the highest number
that can be assigned to incoming bibliographic records is 99999999.

For bibliographic records up to and including OCLC number 99999999, the correct format of the
OCLC number will remain as a three character prefix (ocm), followed by an eight digit number and
a trailing space (e.g., 0cm99999999 ). Starting with record number 100000000, the prefix will be
ocn, the number will be 9 digits in length and have no trailing space (e.g., ocn100000000).

All OCLC systems that output OCLC MARC21 Bibliographic records will be modified to output
different OCLC number formats depending on the number itself (e.g., o0cm99999999[blank] or
0cn100000000).

The target date for all OCLC systems, products, and services to handle the new nine digit number
format is Nov. 1, 2006. OCLC expects to reach 99999999 in the number of bibliographic records
within WorldCat sometime shortly after this date. OCLC plans to have all OCLC programming in
place by Nov. 1 to be prepared on the day they reach that number. Systems will need to be ready
to receive and process this new format of OCLC control number by that same date.

Becky Dean, OCLC; edited

OCLC Support for ISBN 13

OCLC'’s plans for implementing 13-digit ISBN are being finalized. Once the implementation date is

determined, they will announce details a few months in advance. Meanwhile, the following

information was added to their Web page about interim support for ISBN-13:
<http://www.oclc.org/news/announcements/announcement96.htm>
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After OCLC completes the implementation of their new system/database platform, OCLC will add
support for the ISBN-13 numbers in the 020 field for Batchload, online input and searching. In
the future:

o All existing 10-digit ISBNs will be converted to 13-digit ones and both forms will be stored
and indexed in WorldCat records.

e 13-digit ISBNs in field 024 (EAN) will be converted to field 020 and both forms (10-digit
and 13-digit) will be stored and indexed in WorldCat record.

e When a user inputs a valid 10- or 13-digit ISBN, the online system will automatically
generate the other ISBN prior to adding the record to WorldCat unless the ISBN starts with
“979.”

e Reports and catalog card printing will be modified to display or print 13-digit ISBNs.

OCLC; edited

LOCAL HOLDINGS MAINTENANCE

Update on Local Holdings Maintenance Training: New Sessions Added!

Dates have been scheduled for both in-person workshops and webinars. See below for details:

Webinars

Local Holdings Maintenance, Part 1: The focus is on LHRs created by the automated migration
from Passport UL, and trainees will learn how to update and delete basic holdings currently in the
system.

e Thursday, May 18, from 1:30 - 3:00p.m.

Local Holdings Maintenance, Part 2: Creating new LHRs will be the focus of this session, including
adding a second LHR to a bibliographic record, deriving a new holding from an existing LHR, and
creating a new LHR from scratch.

¢ Monday, May 8 from 1:30 - 3:00 p.m.
e Tuesday, May 23 from 10:00 - 11:30 a.m.

Local Holdings Maintenance, Part 3: This session will focus on unusual aspects of updating,
including holdings with multiple levels of detail, holdings with multiple gaps, changes in
publication patterns and holdings in non-print formats. We will be asking participants for input on

MINITEX/OCLC Mailing, May 2006
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what aspects of this work interest them, so we can put focus on practical examples, rather than
trying to cover all corners of LHM.

e Wednesday, May 10 from 10:30 a.m. - 12:00 p.m.
e Tuesday, May 23 from 1:30 p.m. - 3:00 p.m.

Hands-On Training

We are offering two live, day-long training sessions covering the full gamut of Local Holdings
Maintenance issues. These sessions are hands-on, with exercises designed to replicate the LHR
maintenance work that our participants will do in their own libraries. The following sessions are
being offered this spring:

e Tuesday, May 16, University of Sioux Falls, Sioux Falls, SD 8:30 a.m. - 4:00 p.m.
e Monday, May 22, North Dakota State University, Fargo, ND 8:30 a.m. - 4:00 p.m.

To register for these webinars and training sessions, go to:
<http://www.minitex.umn.edu/train-conf/>

Training on Local Holdings Maintenance will continue to be offered throughout the spring and
summer. Stay tuned for upcoming training announcements via the Mailing or the MINITEX news
mailing list. If you have questions, please contact Cecelia Boone or Dave Linton (Contact
information at the end of this Mailing).

Dave Linton; edited

A Reminder: No Update to MULS on PALS or the Gateway this August

Major changes are coming this summer and fall for MULS, the MINITEX Union List of Serials. As
you've all heard by now, OCLC union listing (now called Local Holdings Maintenance -- LHM) has
moved to the Connexion browser, and the MINITEX/MULS staff is offering training to help libraries
deal with this change.

The second major change — the methods through which staff of MINITEX-region libraries can
access MULS information — will come this summer and fall. For many years, MULS holdings
information has been available both online in OCLC and through annually updated files in MNPALS
and the MnLINK Gateway.

As we announced last fall, OCLC discontinued its traditional Serials Union List Offline Products
(SULOPSs) as of Dec. 1, 2005. The SULOP printouts, microfiche, and electronic records files that
MULS participating libraries have purchased for years included the electronic records file that
MnPALS staff used to update the MULS file in MnPALS and the MnLINK Gateway.

The timing of the discontinuation of SULOPs coincides with the planned end-of-life for the PALS
server this fall — after all PALS libraries have moved their work to the Aleph-based MnLINK ILS.
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The current MULS file will continue to be available via PALS & the Gateway until the PALS server is
decommissioned.

This spring and summer, MINITEX/MULS staff will be reviewing current and possible future usage
patterns for the serials holdings information that has made up MULS for the past 34 years. We
need to determine whether the access that's available in OCLC will be sufficient to meet the needs
of MINITEX-region libraries. With MULS serials holdings information readily available online for
Minnesota, North Dakota, and South Dakota libraries through statewide OCLC WorldCat
subscriptions, the question is whether other methods of access are needed to support resource
sharing activities.

MULS staff will be looking at new options that would present MULS holdings online in OCLC. We
will also be tracking OCLC's planning as it develops successors to the SULOP products, which are
important for individual MULS libraries and groups of MULS libraries. OCLC has not yet
announced a timetable for these new, enhanced offline products; for more information, see:
<http://www.oclc.org/unionlist/migration/default.htm=>

Through paper and online surveys that will be distributed in the next 4-6 weeks, we will ask how
you are using MULS in the current environment and how you think that usage may change in the
future. We look forward to receiving your input.

Please feel free to contact Cecelia Boone or Dave Linton if you have comments that you would like
to share at this time (Contact information at the end of this Mailing).

Cecelia Boone, MINITEX/MULS

REFERENCE

Add Reviews, Notes and More to WorldCat Records!

Users of OCLC's WorldCat database may now add reviews, notes and tables of contents to
WorldCat records through a new option that facilitates sharing among library users worldwide.
The user contribution option in the WorldCat and WorldCat-related databases in OCLC'’s
FirstSearch service extends a pilot begun in late 2005 to enable contribution of content to
WorldCat records in the Find in a Library interface of the Open WorldCat program.

User-contributed content helps extend the OCLC cooperative to include record-enhancing
information from non-cataloging library professionals as well as library users. For example, family
members may add notes to records for genealogical materials about their families, or community
members may comment on historical photographs or documents from digital collections about
their communities that reside in the WorldCat database.
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Content, such as notes and tables of contents, may be expanded or edited by other members of
the viewing community. Personal reviews are visible to all WorldCat users, but may not be edited
except by the original reviewer.

A new tab labeled Add/View Comments in the full record displays contains notes, reviews and
tables of content that have been contributed by WorldCat users. Upon release of this new option
within the FirstSearch service, all content contributed through the Find in a Library interface will
be visible. Content added through both Find in a Library and FirstSearch will be visible in all
public views of the WorldCat database.

Users can contribute content immediately after registering a personal account. Their account
allows them to return to the interface at any time, log in and create or revise content. Guidelines
for content contributions are provided, and OCLC monitors all submissions. User-contributed
content is associated with a WorldCat record, but is maintained separately and does not become
part of the record's authoritative bibliographic information.

WorldCat-related databases available through the FirstSearch service, which also include the new
user-contributed content, are Ebooks (Electronic Books), WorldCat Dissertations and Theses, and
all custom-built group catalogs.

OCLC; edited

The Open WorldCat Program and FRBR

The display of WorldCat records in the Open WorldCat program has been simplified to help people
locate specific versions of a title more quickly. Web users who reach the Find in a Library interface
from partner search engines now see consolidated results for different formats of a source work.

OCLC has fully applied the FRBR (Functional Requirements for Bibliographic Records) conceptual
model to the 3-million-record set currently exposed through Yahoo! Search and Google, providing
a deeper view of WorldCat and greatly flattened search results. Someone seeking "Harry Potter
and the Prisoner of Azkaban" in a library, for example, sees a single Find in a Library record for
that work--with all formats listed together under the Editions tab, with the most widely held
instead of separate records that must be individually evaluated for format.

And, after a user has entered a geographic location, the list of nearby libraries that own the work
now displays iconic representations of the formats that each library owns. (lIcons link directly to a
library's corresponding catalog record for that format.) In the consolidated record list, users can
also limit the display of libraries to just those that own the desired format.

OCLC continues to refine and enhance Open WorldCat so member libraries are more visible on the

Web, and their collections are more accessible from the sites where many people start their

search for information. Visit the Open WorldCat Web site for more information about the program.
<http://www.oclc.org/worldcat/open/default.htm>

Learn more about FRBR:
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<http://www.oclc.org/research/projects/fror/>
To see the example “Azkaban” record in Open WorldCat, go to
<http://www.worldcatlibraries.org/wcpa/oclc/41266045>
and enter a zip code or other geographic identifier.

OCLC; edited

Contact Information

MINITEX Bibliographic and Technical Services (BATS), 612-624-4002, 800-462-5348,
mino@othello.minitex.umn.edu (Carla Dewey Urban, Virginia Dudley, Carlos Portillo,
Sara Ring, Mark Wilhelmi)

OCLC Cataloging, ILL, Digitization and Preservation products and services

Edward Swanson, Manager, MINITEX Contract Cataloging Program (ConCats), 612-624-
4002, 800-462-5348, ConCats@tc.umn.edu

Christine Kline, MINITEX Cooperative Purchasing & Electronic Resources Services
(CPERS), 612-624-2924, 800-462-5348, klinel19@umn.edu
OCLC Reference products and services

Cecelia Boone, 612-624-6353, 800-462-5348, c-boon@umn.edu
Dave Linton, 612-624-3360, 800-462-5348, linto001@umn.edu
OCLC Local Holdings Maintenance (formerly Union Listing), including MULS
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MINITEX Calendar of Training, Meetings, and Conferences
May 2006
(Updated May 1, 2006)

This calendar primarily lists events scheduled by MINITEX, although other events are included.
This is an informational posting only, registration materials are sent separately. If you are
interested in attending a workshop and have not received registration materials two weeks prior to
the event, contact the MINITEX Office (612-624-4002, 800-462-5348). For OCLC training
sessions, ask for Kay Kirscht. There is a registration fee for many of the events listed.

Some events listed on the calendar may be cancelled due to lack of registered participants.
Cancellations and changes are highlighted by **CANCELLED** following the date of the event.

This calendar will be updated and posted at the beginning of each month. If you would like your event included in
the calendar, please call Kay Kirscht at 612-624-3532.

MAY

1-5 MN Voluntary Certification Statewide Workshop:
Copyright, Privacy, and Virtual Reference
East Central Regional Library -Wyoming Branch, Arrowhead Library System
Headquarters, St. Cloud Public Library, SELCO Headquarters, Rochester, MN,
and Redwood Falls Public Library
For more information, contact Rebecca Patton at rpatton@arrowhead.lib.mn.us
or 1-218-741-3840

8 Local Holdings Maintenance (Part 2)
1:30 p.m. - 3:00 p.m., CST
Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#100

9 Enhancing Quality Staff
Symposium for library paraprofessionals
Radisson Hotel Metrodome
Minneapolis, MN
http://sdt.lib.umn.edu/egs/

10 Local Holdings Maintenance (Part 3)
10:30 a.m. - 12:00 p.m., CST
Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#101

11 MARC Format for Non-Catalogers
2:00 p.m. -3:15 p.m., CST
Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#12

11 Latino Library Outreach

All Day Workshop

St. Cloud Public Library
St. Cloud, MN
http://www.selco.lib.mn.us/




MAY, continued

12 Tools for Original Cataloging with Using Connexion Client
11:00 a.m. —12:00 p.m., CST
Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#98

15 U of M Libraries / MINITEX Reference Symposium:
“Library as Place: Physical Realms, Virtual Possibilities™
University of Minnesota, St. Paul Campus
Continuing Education and Conference Center
St. Paul, MN
http://sdt.lib.umn.edu/reference/

15-19 Toward Library 2.0: Training, Technology, & the Big Picture
Continuing Education Workshop
http://www.selco.lib.mn.us/apps/training/courseHome.cfm?type=3

16 Local Holdings Maintenance in Connexion
8:30 a.m. - 4:00 p.m., CST
MINITEX / OCLC Training Session
Cleveland Center, University of Sioux Falls
Sioux Falls, SD
http://www.minitex.umn.edu/train-conf/oclc/#106

16-18 Using the OCLC Authority File: Authorities Series #2
9:30 a.m. — 10:45 a.m., CST
A Two Part, Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#96

18-21 International GLBT Library Conference
University of Minnesota, Twin Cities Campus
http://www.lib.umn.edu/events/glbtalms/

18-19 2006 Minnesota e-Learning Summit
Augsburg College
Minneapolis, MN

18 Local Holdings Maintenance (Part 1)
1:30 - 3:00p.m., CST
Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#100

20 Minneapolis Public Library’s Grand Opening
Minneapolis, MN
http://www.mpls.lib.mn.us/ncl_projectsummary102803.asp

22-26 NACO Training
9:00 a.m. - 4:00 p.m., CST
MINITEX / OCLC Training Session
S-30C Wilson Library
University of Minnesota, Twin Cities Campus (West Bank)
http://www.minitex.umn.edu/train-conf/oclc/#102




MAY, continued

23

23

24

4-7

12-13

15

22-28

Local Holdings Maintenance (Part 2)

10:00 a.m. — 11:30 a.m., CST

Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#100

Local Holdings Maintenance (Part 3)

1:30 p.m. - 3:00 p.m., CST

Online Training Session
http://www.minitex.umn.edu/train-conf/webinars/upcoming.asp#101

Latino Library Outreach

All Day Workshop

Pioneerland Library System Offices
Willmar, MN
http://www.selco.lib.mn.us/

Memorial Day Holiday
MINITEX Office Closed

MINITEX Advisory Council

9:00 a.m. - 12:30 p.m., CST

University of Minnesota, Twin Cities Campus
18 Andersen Library

Minneapolis, MN

ELUNA Meeting
University of Tennessee
Knoxville, TN
http://www.naaug.org

27th Annual Children’s Literature Workshop
Holiday Inn

St. Cloud, MN
http://web.stcloudstate.edu/clw/

MOTSE: Cataloging Audio Materials

9:00 AM - 4:00 PM (CST)

Southdale Library

7001 York Ave. So.

Edina, MN
http://www.minitex.umn.edu/train-conf/oclc/#108

ALA Annual Conference - New Orleans

Morial Convention Center

New Orleans, LA
http://www.ala.org/ala/eventsandconferencesb/annual/2006a/2006an.htm




